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Send Us Your Comments

Aras Corporation welcomes your comments and suggestions on the quality and
usefulness of this document. Your input is an important part of the information used
for future revisions.

o Didyou find any errors?

o Istheinformation clearly presented?

o Do you need more information? If so, where and what level of detail?
o Arethe examples correct? Do you need more examples?

o What features did you like most?

If you find any errors or have any other suggestions for improvement, please

indicate the document title, and the chapter, section, and page number (if available).

You can send comments to us in the following ways:

o Email:
Support@aras.com
Subject: Aras Innovator Documentation

Or,

o Postal service:
Aras Corporation
300 Brickstone Square
Suite 700
Andover, MA 01810
Attention: Aras Innovator Documentation

Or,
o FAX

978-794-9826
Attn: Aras Innovator Documentation

If you would like a reply, please provide your name, email address, address, and
telephone number.

If you have usage issues with the software, please visit
http://www.aras.com/support/

All Rights Reserved.

Page 5



1 Introduction

Aras Innovator’s Report ItemType includes support for Microsoft’s "Reporting
Services" in addition to supporting the existing XSLT based reports.

Reporting Services is an integral component of SQL Server 2008, and any customer
with a SQL Server 2008 license can install Reporting Services. (See installation
instructions below).

Usage of this release is recommended only for those with advanced Aras Innovator
and SQL training.

Primary benefits to switching from stylesheet driven reports to Report Server:

Query building is in SQL, and is graphical (same as in Enterprise Manager).

N

Report definitions are transportable, you can develop on your laptop, and
then deploy to a production server.

Report layout is more drag-n-drop and has more powerful formatting tools.
The resulting reports are paginated.

The end-user can easily print, PDF, or export to Excel the report output.

o v AW

Excel like Charts and graphs can be produced

Planned enhancements are a tighter integration of the authentication / permissions
model, and finding an alternative to Visual Studio for end-use report layout.

To learn more about Microsoft Reporting Services visit:

Microsoft SQL Server: Reporting

Copyright© 2013
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http://www.microsoft.com/en-us/sqlserver/solutions-technologies/business-intelligence/reporting.aspx
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2 Installing Reporting Services

Reporting Services is a component of Microsoft SQL server 2008 and can be installed
by selecting the “"Reporting Services” option during the SQL server installation.

e SOIESETVEra 00 BISet i)

Feature Selection

aE

Select the Developer Features to instal. For clustered installations, only Database Engine Services and Analysis Services can be

clustered.

Setup Support Rules
Installation Type
Feature Selection

Disk Space Requirements
Error and Usage Reporting
Installation Rules

Ready to Install
Installation Progress
Complete

Features:

Instance Features
Database Engine Services
SQL Server Replication
Full-Text Search
Analysis Services
eporting Services
Shared Features
Business Intelligence Development Studio
Client Tools Connectivity
Integration Services
Client Tools Backwards Compatibility
Client Tools SDK
SQL Server Books Online
Management Tools - Basic
Management Tools - Complete
SQL Client Connectivity SDK
Microsoft Sync Framework.
Redistributable Features

Select All Unselect Al

Shared feature directory:

Description:

Server features are instance-aware and
have their own registry hives, They
su':vport multiple instances on a computer.

(o ]

Next > H Cancel H Help

J

In addition to selecting the Reporting Services option, you can select “Analysis
Services” which provides graphing and charting functionality.

Selecting the “Reporting Services” option also installs components of Visual Studio

2008 for report design and deployment

2.1 Installation is a component of SQL Server 2008

The following is a summary of dialogs to be used when installing SQL server 2008.

Use the default selections for dialogs not shown here

All Rights Reserved.
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2.1.1 Default Instance

% SOL Server 2008 Setup

Instance Configuration

Specify the name and instance ID for the SQL Server instance.

Setup Support Rules

Feature Selection

Instance Configuration

Disk Space Requirements

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration

¢ Default instance

" Named instance:

[MssqLserver

Instance ID:

[MSSQUSERVER

Instance root directory:

lC:\Program Files\Microsoft SQL Server),

Error and Usage Reporting SQL Server directory: C:\Program FilesiMicrosoft SQL Server\MSSQL10.MSSQLSERYER
Installation Rules Analysis Services directory:  C:\Program FilesiMicrosoft SQL Server\MSA510,MS5QLSERVER
Ready to Instal Reporting Services directory:  C:\Program Files\Microsoft SQL Server\MSRS10.MSSQLSERVER
Installation Progress
Complete Installed instances:
Instance | Features Edition Version Instance ID
SQLEngine,SQLEnQ... |Express 9.3.4035.00 MSSQL.1
< Back Mext > Cancel Help |
4
2.1.2 Service account Setup
4% SQL Server 2008 Setup _ =1o1x]
Server Configuration
Specify the configuration.
Setup Support Rules Service Accounts I Collation I
Product Key
liconse Teme Microsoft recommends that you use a separate account for each SQL Server service.
Feature Selection Service | Account Name Password Startup Type
Instance Configuration w NT AUTHORITY{NETWOR... Manual ;‘
Disk Space Requirements SQL Server Database Engine NT AUTHORITY|NETWOR. .. Automatic hd
Server Configuration SQL Server Analysis Services NT AUTHORITY{NETWOR. .. Automatic hd
Database Engine Configuration Sal Server Reporting Services NT AUTHORITYNETWOR. .. Automatic |
BERE S S e LR SQL Server Integration Services 10.0 | NT AUTHORITY\NETWOR. .. Automatic |
Reporting Services Configuration
Error and Usage Reporting
Installation Rules Use the same account for all SQL Server services
Ready to Install
Installation Progress
Conplete bl Rt s Vo ol et e o e ekl B bl ek
e pecify a low privilege account, For more information, cli

Service Account Name Password Startup Type

SQL Full-text Filter Daemon Launcher j Manual

SQL Server Browser T AUTHORITY{Metwork. .. Disabled ;]

< Back Mext = Cancel Help
4

Copyright© 2013
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2.1.3 Analysis Services Configuration

Analysis Services Configuration

Specify Analysis Services administrators and data directories.

=10l

Setup Support Rules

Product Key

License Terms

Feature Selection

Instance Configuration

Disk Space Requirements
Server Configuration
Database Engine Configuration

ysis Services C i

Reporting Services Configuration
Error and Usage Reporting
Installation Rules

Ready to Install

Installation Progress

Complete

Account Provisioning | Data Directories I

Specify which users have administrative permissions for Analysis Services.

Add Current User l Add... I Remove I

Analysis Services
administrators have
unrestricted access to
Analysis Services,

< Back Mext >

Cancel Help

2.1.4 Authentication Mode

Database Engine Configuration

Specify Database Engine authentication security mode, administrators and data directories.

Setup Support Rules

Feature Selection

Instance Configuration

Disk Space Requirements.

Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error and Usage Reporting
Installation Rules

Ready to Install

Installation Progress

Complete

Account Provisioning | Data Directories | FILESTREAM

Specify the authentication mode and administrators for the Database Engine.

Authentication Mode
" Windows authentication mode

¢ Mixed Mode (SQL Server authentication and Windows authentication)

Built-in SQL Server system ini account

Enter password: |o

Confirm password: |uuuu.

Specify SQL Server administrators

Administrator (Administrator)

Add Current User Add...

SQL Server administrators
have unrestricted access to
the Database Engine.

< Back Mext >

Cancel Help

All Rights Reserved.
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2.1.5 Reporting Services Options

W% SOL Server 2008 Setup B

Reporting Services Configuration

Specify the Reporting Services configuration mode,

=lolx]

Setup Support Rules

Feature Selection

Instance Configuration

Disk Space Requirements
Server Configuration

Database Engine Configuration
Analysis Services Configuration
Reporting Services Configuration
Error and Usage Reporting
Installation Rules

Ready to Install

Installation Progress

Complete

¢ Install the native mode default configuration.

Setup will install the report server and configure it in Mative mode to use the default values. The report
server is usable as soon as Setup is finished.

" Install the SharePoint integrated mode default configuration.

Setup will create the report server database in SharePoint integrated mode and configure the report server ta
use the default values. However, integrated operations will not be supported until a minimal installation of a
SharePoint product or technology is deployed on the report server computer and the Reporting Services Add-
in for SharePoint Technologies is installed and configured on the instance of the SharePaint product or
technology you are using.

" Install, but do not configure the report server,

Setup will install, but will not configure, the report server software, After installation is finished, you can use
the Reporting Services Configuration tool to set options that are required to run the report server,

< Back Next > Cancel Help

2.1.6 Remaining Selections

The default selections can be used from this point forward.

Copyright© 2013
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3 Configuring Reporting Services

The Reporting Services use Folders to organize Reports. The Aras Innovator
integration with Reporting Services use as a default the Folder named "Innovator
Reports"

In this section we will configure the Reporting Services using the Report Manager by
adding the "Innovator Reports" Folder and a Shared Data Source, which the Reports
use to connect to the database.

3.1 Add Reports Folder

The Reporting Services ReportServer comes with a Report Manager page used to
configure the Reports, Folders, Data Sources, and so on. This page has been
integrated into Innovator client via an Innovator Report that opens the Report
Manager page.

Open your browser with the URL http://localhost:8080/Reports (on a default install)

If your installation is not default, open the Reporting Services Configuration Manger
to verify the URL

E Reporting Services Configuration Manager: ANDOYER\MSSQLSERYER 2008

= Mirosoft SQL Server 2008 Reporting Services

Iﬁj Reporting Services Configuration Manager

2 connect
2 Cor Report Manager URL
5 ANDOVER\MSSQLSERVER2008
Configure a URL to access Report Manager, Click Advanced ko define multiple URLs, or to specify
B corvice Account .‘ additional parameters on the URL,
=h
A Web Servics URL Report Manager Site Identification
wirtual Directary: Reporks_MSSQLSERVERZ008
3 Database
URLs: http: {/ANDOVER:80/Reports MSSOLSERVERZONS Advanced
hitbpsiffandover 443/Reports MSSOLSERYER2008 —
' Report Manager URL
4 E-mail Settings
ﬁ Execution Account
T4 Encryption Keys
,-“",-‘ Scale-out Deplayment
4 1 &

L2 fapply Exit

Copyright© 2013
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1. The Report Manager page will open in a new window as shown below:

] Report Manager - Microsoft Internet Explorer

File Edit “Wiew Favorites Tools  Help

eBack @ -\-) @ @ <h pSearch *Favorites @ Bv .{_!\; = ."3

Address @ http:f{laptop07 reports (Pages/Folder . aspx v| &

Links > & Snaglt

=S

Home | My Subscriptions | Site Settings | Help

— SQL Server Reporting Services
Search for:|

[

iz Home

L1l Properties
n -

$D Mew Folder ) @ Mew Data Source 4] Upload File 5] Report Builder

£ Show Details

Mems in Home. Click Help for more information about this page.

2. Click on the "New Folder" button.
3. Enter "Innovator Reports" for the name and click the OK button.

] Report Manager - Microsoft Internet Explorer

File Edit “Wiew Favorites Tools  Help

@Back @ -\-) @ @ (b pSearch *Favorites @ 8' .{_;1 = ."3

Address @ http: /flaptop07 [Reports/Pages/FolderProperties, aspx?CreateMew=TruefltemPath="%:2fNew+Folder&R edirectUr|= V| Go

Links & snaalt B

Home | My Subscriptions | Site Settings | Help

— SOL Server Reporting Services
i New Folderp : Search for:| |
Create a new folder in Home.
Mame: |Inn0\.rat0r Reports
Description:
[IHide in list wiew
If you use a folder named something other than “Innovator Reports”, you will need
to change the “Report Server Folder” variable in the database as well in
Administration\Variables in the TOC. The default value for this is “Innovator
Reports” but can be customized for each database. For the purposes of these
instructions, we will assume the default value is used.
3.2 Add Shared Data Source
Once you add the "Innovator Reports" Folder navigate into it by clicking on the link.
Now you will add a Shared Data Source for the Reports to use to connect to the
database.
Page 12
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1.

Click on the "New Data Source" button in the center of the page.

J Heparl Managar - Microssdl Intermel Exploder r; IT:| El
Fle [ Vew Feeobes  Tock  belp &
Ome - Q W@ Pued v @ -5 F- B
] i Tt ot R ot Prasges Fokiher digon T TP athes 0, 2 Invucrs st + oGt sl Vupnieiodde=L it v B s " Snxn ] o
SOL Server Faporing Seraoes o ¢ My SubSCrotons | Sie Setlngs | Hel
| Homs > Search far Gal
“S Innovator Reports (el
[PETST MY Presserting
| =
a New Folder | 80 New Doty Source | o] Upload File 7 Report Buslder Hl Shaw Detads
s
Duta Sovrce)

Enter "Innovator" for the Data Source Name. By using this same name for
both the development and production servers exporting/importing Reports
becomes simpler because there will be no need to reassign the Data Source
for the Reports you import.

Enter the following for the "Connection String" replacing the values for the
two parameters with the actual server name where SQL Server is installed
and the actual database name.

data source=<SQLServerName>;initial catalog=<InnovatorDatabase>
e.g.

data source=serverl;initial catalog=innovator

Select the "Credentials stored securely in the report server" choice for
the "Connect Using" Field and enter the login credentials for your database.

Click the "Apply" button to deploy the shared Data Source.

L= J51X]
°C — froofd [#2] X £+

G

Fle Edk Wew Favorkes Toos Heb
DARMON « /@0« @ DAEMONTocls Lke = % Astroburn [ Products « [ Acncuncements [2] (5 Forum posts [15] ) Weather ) TP-bokup sy Translate « £ Game Database % Toobar Corfig

& | @repatmeneger [+ B B v e s Grods -
Home | My Subscriptions | Site Settings | Help
#  5QL Server Reporting Services 3
“”  New Data Source Search for:

Name: innovator

Description:

[Hide in st view
[Enable this data source
Data Source Type: | Microsoft SQL Server

Connection string:  |data source=scoleman02
\MSSQLSERVER2008; initial catalog =
ReportServer2008

<]

EmE

Connect using:
O Credentials supplied by the user running the report

@ Credentials stored securely in the report server
User name: |innovator
Password:  essssssssl |

[Juse as Windows credentials when connecting to the data source

o the user after a has been mads to the data source

© windows integrated security

© Credentials are not required

Dene T S Lecalinranet H100% -
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3.3 Add Reporting User and Role

The ReportServer.asmx Web Service is the Report Server entry point for the
Microsoft Reporting Services. The same Web Service is used to request Reports and
administer the Report Server. The Web Service is by default configured to use
Windows Authentication. You can't simply open the security for anonymous Web
users because that would open the Report Manager as well.

This security model requires the User be authenticated when they request Reports. A
dialog will open requesting the user's login credentials the first time they request a
Report each time the browser is opened again. When requesting the Report from
within Aras Innovator this would not be desirable. This also means the user must
have a domain or local User Account on the server and that becomes an issue for not
100% Microsoft shops with Intranet only Aras Innovator.

The initial release of the Aras Innovator Reporting Services will use one shared User
Account for all Report requests. The Aras Innovator Client will call the Aras Innovator
Reporting Services Gateway to request Reports. The Gateway will submit the actual
Report request using this shared User Account and propagate the results back to the
client. The Report will render without the authentication dialog appearing.

If the user attempts to view the Report directly outside Aras Innovator they will get
the authentication dialog as normal and unless the IT department shares the
credentials the users will only be able to view the Reports through Aras Innovator.

The local User Account on the server by default is named "Reporting" with a default
password will be "reporting" and must be mapped as a Role in the Report Server.

3.3.1 Add local User Account for Reporting

The administrator for the server where Microsoft Reporting Services is installed must
add a new Windows User Account named "Reporting". Once the User Account is
created you can configure Aras Innovator by setting the user name and password in
the InnovatorServerConfig.xml configuration file:

<ReportingServices>
<ReportServer>http://localhost/ReportServer/</ReportServer>
<User>Reporting</User>
<Password>reporting</Password>
<Domain>Domain for the above User</Domain>
</ReportingServices>

Optional node, <Domain>, should contain the domain name you want to use to
connect to Reporting services.

3.3.2 Add the Reporting Role

The Reporting User Account must next be mapped as a Role in the Reporting
Services enabling this account Browser privileges.

1. Click on the "Site Settings" link in the upper right hand corner of the Report
Manager page.

Copyright© 2013
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‘A Report Manager - Microsoft Internet Explorer

Fla Edt Wew Favorkes Took  Hep e
aback' ] Iﬂlﬂfh /_;Saudn\hf'me@ ;ﬁ._g-.f Ev‘;j

adress | €] it lapkopdTreports{Pages Folder. aspx v B s i

Homeg | b iptionsf] Site Sptti '
= SqL Server Reporting Services ]
Home 4 Search for: J

| contents VRN

[uNew Folder +pMNew Data Source 4] Upload File ] Report Builder if Show Details

3 [nnovator gggg.r:s IHE'W

2. Next click on the "Configure site-wide security" link.

‘2 Report Manager - Microsoft Internet Explorer [:]IE'.[?]
Fle Edk Wew Favorbes Took  Help ]
Qs - @ [¥ B @ Poewr Jorons @ -2 F- B
Address | ] Hetp:iflaptopdT Reports Pages Settings. s v B i ? @ s [
Home | My Subscriptions | Site Settings | Help -~
o SQL Server Reporting Services
22|  Site Settings Search far:
Settings

Wame: |SQL Server Reporting Services |

[] Enable My Reports to support user-owned folders for publishing and running personalized reports,
Choose the role to apply to each user's My Reports folder: | My Reports |

Select the default settings for report history:
@ Keep an unlimited number of snapshots in report history
CrLimit the copies of report history: .

Report Execution Timeout
O Do not timeout report execution .
@ Limit report execution to the following number of seconds: 1800

[#]Enable report execution logging .
Flremove log entries older than this number of days: |60

] hitp: ] laptop(7 R epartsiPagesiSystemSecurkty aspx & Local intranet

3. Next click on the "New Role Assignments" button to map the Reporting
User Account as a Reporting Services Role.

‘A Report Manager - Microsoft Internet Explorer [: [l=] [il
Fie Edt View Favortes Took Hep aw

Qs - © - M @ @ Pt Fermone: @ 2- 5 H- B

acdress | 8] bt lapopT{Repcrts{PagesiSystemSecuty a%px v B ks @smeor B
Home | My Subscriptions | Site Settings | Help
SOL Server Reporting Services
&’J:f Systemn Role Assignments Search for:
X || AF New Rolghssignment |

(] Group oF Userd [New Role Assignment | rale(s)

[ Edit BUILTIN\Administrators System Administrator
Copyright© 2013
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4. Enter the User Account name Reporting and check the "System User"
checkbox and click the "OK" button to create the new Role.

CEX

| Report Manager - Microsoft Internet Explorer,
1

File Edit “iew Favorites Tools  Help

2 i ~ T
- ) j 2] ( = i A - & ] -
e Back. J x =1 lj /D Search [\“‘}/\( Favatites ﬁz [\ == &
Address |@ http:,|’.|’IaptopD?,l’Reports,l’Pages,l’EditGroup.aspx?lﬂsamPath=&RedirectUrI=http%Sa°.-"02f°.-"02FIapt0pD?°.-"o2FRep0rts%: V| Go ks 7 @ snagt B B

Home | My Subscriptions | Site Settings | Help

SQL Server Reporting Services
rp{‘ New System Role Assignment Search for:| &

Use this page to assign a user or group to a system role, You can also use this page to create or modify a system role
definition,

Group or user name: |Reporting

Select one or more roles to assign to the group or user,

[0 FRale+ Diascription

[0 System Administrator  Yiew and modify system role assignments, system role definitions, system properties, and
shared schedules,

System User Yiew system properties and shared schedules,

[ Cancel ] [ MNew Role

5. Next we need to add the new Reporting Role to the "Innovator Reports"
folder's security. Click on the "Home" link in the upper right hand corner on
the page, then on Show Details and select the Edit icon for the Innovator

folder.
A Report Manager - Microsoft Internet Explorer |Z||E|r5__<|
File Edit “iew Favorites Tools  Help ':;'
1 A =y .. . o N |
eBack - J \ﬂ @ ._lj /.JSearch “‘}/\( Favorites e} [-_-.--_-_\v =1 - 'ﬁ
Address |@ http:{{laptop0?/Reports/Pages/Folder . aspx?SelectedTabld=ContentsTab&ViewMode=List V| Go Links 7 & Snaglt E [ea]
Home | My Subscriptions | Site Settings | Help
SQL Server Reporting Services
Home Search fur.| |

m

[iMew Folder < Mew Data Source 4] Upload File 5] Report Builder

3 Innowvator Reports Iuew Shiow Details

£ Show Details

6. Click on the "Security" link on the left had side of the page to open the
Security page for the Innovator Reports folder.
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‘A Report Manager - Microsoft Internet Explorer
File Edt Wew Favorbes Took  Help

Qo - @ - [x] [B] @ P Jrramies @ - EF- B

Acdress | ] hitp:flaptopdT(Reports/Feges Folder sz enPathm i 2flnngvator-+ieportsiiewtode=DetaliSelectedTablds v: EJso irks * @ smen B i

Home | My Subscriptions | Site Settings | Help
Search for:

EE3
[

S0L Server Reporting Services
Home =
Innovator Reports

Contents

Properties

Modified Date: 2/6/2007 5:55 PM
General Modified By:  ARAS-CORP\mbeaulieu
Creation Date: 2/6/2007 5:55 PM
-'!'E Created By:  ARAS-CORP\mbeaulieu

St rie-based secunity on Infovabor Reports o determne
the: tasks that users can pesform

Description: |

[CHide in list view

|Appl\,r ] | Delete | [Mwe ]

7. Click on the "Edit Item Security" button.

2 Report Manager - Microsoft Internet Explorer

Fila Edt VWew Favortes Tooks Help

Qe - © - [x] A P Joranns @ -5 (F- B

Address t] kg [laptopOT Reports Page: Folder  aepxt ToamP sth="52f Innov stor +RsportsiViewode=Det sitSelectad TabTd=Froparties TabiSel V: EdGe Urks * @ Snaglt E E

Home =

SQL Server Reporting Services

Innovator Reports

Home | My Subscriptions | Site Settings | Help
Search for: E

e L

&, Edit Itgm Security
General

Securit Group or US?}E:W‘ Security

BUILTIN\AdmirisErators

Faole(s)
Content Manager

8. Enter the Reporting Role and check the "Browser" checkbox and click the
"OK" button to create a new Role Assignment for the Innovator Reports
folder.

) Report Manager - Microsoft Internet Explarer

Favoites  Took  Heb ' I
: . A a
Q- @ [6 @ @ Pt rowne @ R B~ B
ckdess | ] betp:fflapkopd7 Reperts{Pages Ed Group. sspiltemP sthe 2 rervakor +ReportsiRedrectUil=http 3% 2f lfloptopdT%afRepart ¥ | (] G0 Liks @ soaox [ 1
Home | My Subscriptions | Site Settings | Help
(-E‘f Search for:

Fils  Edt  Wew

SQL Server Repclrt_ing Sarvices
MNew Role Assignment

Use this page to define role-based security for Innovator Reports.
Group or user name: |Reporting

Select one or more roles to assign to the group or user.

[ Roled Description
[ Browser May view folders, reports and subscribe to reports.
ay manage content in the art Server. is includes folders, reports and resources,
May a tent in the Repart S Th ludes fold ports and
O My Beports May publish reports and linked reports; manage folders, reports and resources in a users My Reports folder.
[ Publishar May publish reports and linked reports to the Report Server.
i May view report definitions.

[0 REeport Builder
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4 Using Visual Studio for Report Design

Once the Reporting Services is installed you need to configure Visual Studio to create
a Project to hold the Reports. Plus configure a Shared Data Source, which is the
database connection information for the Reports.

NOTE: It is required that you follow the exact naming conventions as shown here to
ensure that the Aras Innovator integration with the Reporting Services will work
correctly.

4.1 Create a New Report Project

Start Microsoft SQL Server Business Inteligence Development Studio and
create a new project named "Innovator Reports". This becomes the Reporting
Services Folder to hold the Reports for Aras Innovator.

M Fites and Settings Tr el e B Analysis Services
Wizaed ) Configuration Tooks b
) Dooumentation and Tuborials ¥

AllPrograms I | . ST IEY ) Pedormance Took

e Server Busingss Inbeligence Development Studio

B oot (O] oo pregepmm——rrer
Bl ommon7| IDE

Mew Project

Project tvpes: Templates; |§|
Business Inteligence Projects ¥isual Studio installed templates
Other Project Types
(5l Anatysis Services Project @Impnrt Analysis Services 9.0 Datab. .
:ﬁlntegration Services Project ":, Report Server Projest Wizard
[E]report Model Project @ Report Server Project
My Templates
i Search Cnline Templates. ..
Create an emgw'ﬁepart Server projeck, \ |
)]
Marne: wnavatar Repurts| / |
o
Location: | Y Dacoments and Settings|mbeaulizut My DocumentsYisual Studio 20054 projects ~ | [ Browse, .. l
Salution Mame: | Innovator Reparts | Create directory For solution
[ CE l [ Cancel ]
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4.2 Configure Project Properties

Open the "Solutions Explorer" panel from the menu View->Solutions Explorer if
it is not already opened.

Right mouse click on the "Innovator Reports" folder and select the Properties
context menu choice.

On the Properties dialog set the TargetServerURI field to the URL of the Report
Server. For example, http://localhost:8080/ReportServer where the actual name of
the server host name is entered in place of localhost.

Also set the OverwriteDateSources flag to True.

Innovator Reports Property Pages E §|
Configuration: | ActivelDebug) v [ Configuration Managet, .. ]
[=] Configuration Properties El Debug
General Startltern
El Deployment

OvenariteD ataSources @
TargetD atas ourceFolder [Yata Sources
T argetReportFolder Innovator Reports

http: £ flocalhozt/R eportServer

TargetServerURL
The URL of the report server to which to deploy the project, for example,
http: /hostname/R epartS erver.

Ok, ][ Cancel ][ Apply

4.3 Add New Shared Data Source

In the same "Solutions Explorer" panel right mouse click on the "Shared Data
Sources" folder and select "Add New Data Source" context menu choice. Click on
the Edit button to configure the new datasource

4.3.1 Connection Properties

1. Select or enter the "Sever name" for the machine SQL Server is installed.

2. Select the "Use a specific user name and password" radio button choice and
enter the login credentials for the database and check the Save My password.

3. Select or enter the "Database name".

Copyright© 2013
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" Shared Data Source

General | Credentials |

Marne:

|Inn0vat0r

[ Type:

B |Micr050Ft S0L Server

Conneckion skring:

b

[ QK ] ’_ Cand

oy e
Jration Services (How, ..
arking Services (Haow ...
Ed

oIy

JUST RELEASED! Web Service Sof]

Wed, 26 Jul 2006 00:44;00 GMT - This
quality services and achiewve more pred
Skudio 2005,

Inside MSDM: Building the MSDN

fon, 26 Jun 2006 19:03:59 GMT - This
buile atop SOL Server Service Broker,

Data Points: Reporting Controls ir|
MMon, 26 Jun 2006 15:58:01 GMT - SQL

Connection Properties

Ers

Data source:

|Micmsoft SOAL Server [SgiClient] | [ Change... ]
Server name:
|Laptop0? vl [ Refresh l

Log on to the server

(73 Use Windows Authentication
() Use S0L Server Authentication

User name: |inn0vat0r

Pazsward: |oooooooooo

Save my password

Connect to a databaze

(=) Select ar enter a database name:

Browsze...

’,
wvarious properties of that repart and a
adines | oo
patterns and practices Goes Mobi .
Attach a databaze file:
—_— Thu, 03 Jun 2006 00:15:3 GMT - The © Attach a database file
:nges from {CTP) Far the Mobile Client Software Fy |
sl Logical nanme:
’,

[ Test Connection | [

0K ][ Cancel ]

ecifically For 0L Server beginners—individuals who are
onnect ko SQL Server Express databases,

ion is the successar ko SQL Server 2005 Mabile Edition
nchronization capabilities available in SQL Mobile,

ar

hir

ki
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4.3.2 Deploy the Shared Data Source

By default the name of the Shared Data Source is the name of the Database you

selected above. You can rename this if you want. Finally you need to deploy this new
Shared Data Source.

Solution Explorer

=

,E::,] Innovator Reports
=~ | Zr shared Data Sources

BN oot - IR

1 Repo

§)

X i o

Qpen
Exclude From Project
Zuk

Copy
Delete

Renarme

Deploy

Propetties
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5 Creating your First Report

The following illustrates using the Report Wizard to create a new Report. For this
Report we will create a simple User Directory Report showing the Users First Name,
Last Name, Email, Phone Number, and Company Name. The following is a screen
shot of the Report that we will be creating:

5.1 Start a New Report using the Wizard

From the "Solution Explorer" panel right mouse click on the "Reports" folder and
select the context menu choice "Add New Report".

Solution Explarer

4 Innovator Reports
= | Shared Data Sources

«3 Innavator.rds
]  Add Mew Repart
A

dd 3

ie= Properties
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5.2 Select the Data Source

You can create a unique Data Source for this Report but it typical that you use the
default Shared Data Source that you just created above.

E Report Wizard

Select the Data Source —
Select a data source from which bo obtain daka For this repaort of create a new data
SOUFCE,

(¥) shared data source

| Innosatar W |

() Mew data source
Marne:

|Data5::uuru:el |

Twpe:
Microsoft S0L Server

Conneckion skring:

Edit...

Credentials. .

Make this a shared data source

[ < Back ]L Mext = J Finish =]
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5.3 Design the Query

You need to provide the SQL Select query that will get the data for the Report.

In many cases you can enter the simple select clause in the dialog directly.

E Report Wizard

Design the Query

Specify a query to execute ko get the data for the repart,

Ilse a query builder to design wour query,

[

Quety Builder, ..

Query string:

select first_name,last_name, email, telephone From [user]
order by lask_name

T e

NOTE: It is possible to pass Named Parameters into the query such as:

SELECT * FROM [PROJECT] WHERE id=QID

The "Edit..." button opens a Query Builder interface, which will be covered in more

detail later.
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5.4 Select the Report Type

There are two choices for the Report Type: Tabular (column layout) and Matrix (rows
and columns layout). Select the Tabular type:

& Report Wizard
Select the Report Type

(%) Tabular

() Matrix

Select the bype of repart that wou wank bo create,

B(=](E3

Lt
W
Lt
Wi
W
Lttt
Wi
W
Lt
W
LAt hH

Lt
W
Lt
Wi
W
Lt
Wi
W
Lt
W
LAt hH

EEb e
i
EEEEH
i
i
EEb e
i
i
EEb e
i
i

R
i
i
i
i
R
i
i
R
i
i

R
i
i
i
i
R
i
i
R
i
i

< Back. ] [ Mext =

|[ Finish == |[ cancel
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5.5 Design the Table

Select the fields that you want to show on the Report. In this case we were selective
about which fields to return from the query select clause so we want all the fields.

& Report Wizard

Design the Table
Choose how bo group the data in the kable,

fvvailable fields: Displayed fields:
HEHK
HHHY
HERXK
MM
N WM HR
N WEN HE
+ M
L M W
B W H
firsk_name
last_name
email
telephone
l [ Finish ==| ] [ Cancel

< Back. ] [ Mext =
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5.6 Choose the Table Style

Select the style for the table for the Report. This example will simply use the default

bold style.

£ Report Wizard

Choose the Table Style
Choose a skwle For the table.

Carporate
Bald
Qcean
Generic

XXAXX XK
AxEE
E N R R T EE T
mm EEZZ e
b MY HMEX
HARH A B B HHNW
MENE R b MY HMEX
HARH A B B HHNW
MENE R b MY HMEX
HARH A B B HHNW
MENE R b MY HMEX
HARH A B B HHNW
MENE R b MY HMEX
AN HHNH HHHH HHNH HHENN
M A o NN HHEX
AN HHNH HHHH HHNH HHENN
M A o NN HHEX
e Y W W Y
< Back. ] [ Mexk = l [ Fimish ==| ] [ Cancel
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5.7 Name the Report

The final step in the Report wizard is to name the Report. NOTE: The Report Name
must be chosen to be meaningful and will be the same name you set as the name of
the Report Item in Aras Innovator.

£ Report Wizard |:||E|rz|
Completing the Wizard i

Provide a name and click Finish ko create the new report. l'

m

u.Llser Repart J |

Report surmmarsy:

Data source: lnnovator

Connection string; Data Source=Laptopdy;Initial Catalog=lnnovatord
Repart type: T able

Layout type: Stepped

Style: Slate

Detailz: first_name, last_name, email, telephone

[Quen: zelect firgt_name, lazt_name email telephone from [uzer]
order by last_name

Preview report

Help

Finish l [ Cancel
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5.8 Wizard Report Results

The Report wizard will build the report, which will look like the following screen shot:

User Report

Innovatar Admin
Yault admin
Aras PLM
Super Liser

Once the Report is opened in the Layout Tab you can make further changes as you
please. In this example we will camel case the column headers for example, first
name becomes First Name and we will resize the width of the table and the columns
to take up 6.5 inches horizontally.

5.9 Visual Studio Layout
The Report pane has three Tabs:

e Data: For editing the query for the Report. Look at the appendix in this
document to see a more complex Report query example, using the graphical
query builder instead of the wizard.

¢ Layout: For visually designing the Report with drag and drop functionality.
e Preview: For viewing the finished report with real data.

The "Properties" panel on the right is used for setting fonts, color, and other visual
properties.

The "Fields" panel on the left is used to drag database fields onto the report.

The "Toolbox" panel also on the left is for dragging Report controls onto the Report
layout. This is how you can add tables, labels, images, and charts to the Report
layout.

Tips:

e Use the View->Fields menu pick to open the Fields panel when in Layout
mode.

e Use the View->Toolbox menu pick to open the Toolbox panel.

e To open the Header and Footer right mouse click to open the context menu in

the pink field in the Report layout.

All Rights Reserved.
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5.10 Deploying the Report

Once you are satisfied with the Report query and layout as viewed from the Preview
Tab you need to deploy the Report to the Reporting Service. From the "Solution
Explorer" panel right mouse click on the "User Directory" Report item and select the
context menu choice Deploy. Watch for error messages in the output window at the
bottom of the frame.

Solution Explorer

.5 Report Project2

=l | & Shared Data Sources
1-} Inniovator . rds

—|- L Reports

3 Open

Wiew Code

[id] [

View Designer
Exclude From Project
Cuk

Copy

X o

Delete

Fename

Build

| Deploy |

Fun

i—L  Prronerkies

5.11 Confirm Deployment

To confirm the new report has been deployed, open IE Browser and navigate to
http://localhost:8080/Reports. You should see the "Innovator Reports" folder.
Click on that link and you should see the report you just created

Select the hyperlink for the new Report and it will be opened and run the Report.

NOTE: The URL for directly testing this report outside of Aras Innovator would look
like this: http://localhost:8080/ReportServer?/Innovator Reports/User Directory

5.12 Running the Report from within Aras Innovator

In order for users to run the new Reporting Services Report from within Aras
Innovator you need to create an Innovator Report Item. The important settings to
enable the Innovator/Reporting Services interface are:

e The Innovator Report Item name must be exactly the same as the Reporting
Services Report name.

e The Location Field choice must be set to the new "Service" option.
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e The Report Query Field specifies the parameters that will be passed to the
Report Server.

5.12.1Adding Aras Innovator Report Item

e Log into Aras Innovator as admin.
¢ Navigate to the /Administration/Reports off the main tree item.
e Click the New button on the main Toolbar.

e When the new Report Form opens enter the name of the Report (again this is
the name you specified when you created the Report in Visual Studio).

e Select the Report Type, which in this case is "Generic" meaning this Report,
is available always.

e Select the Report Location, which in this case is "Service".
e Select the Report Target, which in the case we want "Window".
e Because this sample Report is of type ItemType there is no Report query

Value.
2 Report - User Directory - Windows Internet Explorer == -
File Edit Views Search Reports Tools Help
) B I M [
Report | Stylesheet
Name: Type Location:  Target: Description: Method
|User Directory | [Generic - [5ervice - |Onel‘u‘indnw. [ [ -]
Label:
Report Query

Note: If you are using FireFox, you have to manually enter a stylesheet under the
Stylesheet tab.

e Test the Report by clicking on the Reports main menu bar choice and you
should see the new "User Directory" choice. Click on the menu choice and
you should see a new window open with the "User Directory" Report.

5.12.2Passing Named Parameters to the ReportServer

As bullet 4 describes in the section 2.1 Report Server Variable the value of the
Innovator Report Item Property report_query is appended to the ReportServer URL
providing additional parameters to control the ReportServer.

For example, the ID of the Item can be passed as the Named Parameter @ID for the
SQL Select for the Reporting Services Report as in this example:

SELECT * FROM [PROJECT] WHERE id=Q@ID
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To pass the ID for the context Item (the selected Item) on the URL to the
ReportServer the Innovator Report Item report_query Property would look like this:

np:id=<xsl:value-of select="@Qid”/>

This is actually an XSLT stylesheet fragment and is the directive for Innovator to add
the string sid=ACBDEF0123456789ACBDEF0123456789 to the end of the ReportServer

URL (but the actual ID value will be used of course).

In this case the Innovator Report is of type Generic so no ID is required but perhaps
we want the Reporting Services Report to be returned in PDF or Excel format. We
can control the ReportServer by adding the following parameter as the report_query
value for the "User Directory" Report: rs:Format=PDF

a2 Report - User Directory - Windows Internet Explorer = [ = -
File Edit Views Search Reports Tools Help
B = E © [
Report  Stylesheet

Name: Type Location:  Target: Description: Method
[User Directory | [Generic JBll [Service [l [one window Bl | ] -
Label:

Report Query
rs:Format=PDF

Ready Aras Innovator

Note that if you need to include more then one parameter for the report_query value
you will need to use the Entity samp; rather then the actual & symbol to delimit the
parameters. Recall that the report_query value is eventually part of the query_string
for the URL to the ReportServer but is actually an XSLT stylesheet fragment and so
the special symbols like <, >, and & need to be protected in XML need to be entered
as Entities &lt; &gt; and &amp; respectively.

For example, to pass the Named Parameter ID and also the Format PDF in the same
report_query the value would look like this:

np:id=<xsl:value-of select="Q@id”/>&amp;rs:Format=PDF
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6 Report Server query_string Parameters

There are several parameters that you can use to control how the Reporting Services
run your Report requests. You include these in the Innovator Report Item's
report_query property, which the client will then use to form the query_string for the
ReportServer request:

6.1 Named Parameters

Named Parameters passed onto the SQL Select query. For example,
np:last_name=Kohl

Would map the value Kohl to the Named Parameter @last_name in the SQL Select:
SELECT * FROM [USER] WHERE last_name=@last_name

6.2 Format Parameter
Format parameter to control the format the Report is rendered:

rs:Format=XML
rs:Format=PDF
rs:Format=HTML4.0
rs:Format=MHTML
rs:Format=EXCEL
rs:Format=Word

6.3 Report Toolbar
Turn off the Report Toolbar:

rc:Toolbar=false

6.4 Parameters Form

Turn off the Parameter Collection area above the Report, which is a simple
dynamically created Form with Fields to allow the user to enter input for the Named
Parameters for the SQL Select query. The Named Parameters passed on the
ReportServer URL query_string are shown and the user fills in the rest:

rc:Parameters=false
rc:Parameters=Collapsed

6.5 Zoom

Control the zoom:

rc:Zoom=100

rc:Zoom=% zoom as integer
rc:Zoom=Page Width
rc:Zoom=Whole Page
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6.6 Reports Folder

The default Folder where Reporting Services Reports are deployed is in "Innovator
Reports" however, you may deploy the Reports in other Folders and you specify this
using the this Paramater:

irs:Folder=Your Folder Name

6.7 Report Name

The Aras Innovator client will automatically append the Parameter to specify the
Report to run on the query_string, which is the name of the Innovator Report Item.
However, if run reports programmatically you may need to set this directly yourself:

irs:Report=Your Report Name
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/ Report Manager

The Reporting Services ReportServer comes with a Report Manager page to
administer the Reports, Folders, Data Sources, and so on. This page has been
integrated into Aras Innovator client via an Innovator Report that opens the Report
Manager page (see section 2 Configuring Aras Innovator for more information about
this Report Item).

Reports that are created and tested on the development machine can be moved to a
production ReportServer by exporting the RDL file for the Report from your local
development machine and then importing it into the production machine.

The process of exporting a Report and importing it into another ReportServer and
enabling the Report in Aras Innovator is a four step process:

1. Export the RDL file via the Report Manager page.
2. Import the RDL file via the Report Manager page.
3. Reassign the Data Source to the imported Report.
4

Add an Innovator Report Item to call the Reporting Services Report.

7.1 Opening the Report Manager page
1. Navigate to the main tree item /Administration/Reports.
Click on the main menu Reports button and the "Report Manager" choice.
The Report Manager page will open in a new window as shown below:

You may need to click on the "Show Details” button

2 Report Manager - Microsoft Internet Explorer Q@E|
Fie Edt View Favortes Tools Help "
7 A B < A .

QBack M 7 ﬂ IELI ol | Search . Favorites {‘! T @ .“‘

Address | &) hetp:jflapop07 jreports{PagesiFalder. aspx?YiewMode=Detai e a Go  Lnks ¥ @ Snaglt B L

Home | My Subscriptions | Site Settings | Help

SQL Server Reporting Services

[ Home Search for:
x Eid | CyMew Folder €9 MNew Data Source 4] Upload File 5] Report Builder i Hide Details
] Edit Type  Named Description Modified Date Modified By when Run
O [ [ ] Data Sources 2/9/2007 9:47 AM ARAS-CORPYmbeaulieu
O = a Innowvator Reports 2/7/2007 12:10 PM ARAS-CORPYmbeaulieu
g‘] ‘3 Local inkranst

Note: This same page can be opened from your browser with the URL
http://localhost:8080/Reports
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http://localhost:8080/Reports

7.2 Export the RDL

To export a RDL file for a Report, click on the "Innovator Reports" Folder. You will
see a list of Reports and Shared Data Sources.

3 Report Manager - Microsoft Internet Explorer _ | D'll

File Edit ‘ew Favorites Tools  Help

Qo - © - [ R3] Pomes Jyrwenm @] 11 - B B3
Address @http:,l’,l’\ocalhost,l’Reports,l’Pages,l’Folder.aspx?ItemPath=°.v‘02FInnovator+RepDrts j G @Snaglt =) | g1
Home | My Subscriptions | Site Settings | Help ;I

Links

oy SOL Server Reporting Services

Iliy Hame > Search for: | El

Innovator Reports

.

K Delete B wove | [*New Folder #dMew Data Source T Upload File i Hide Details
r Edit  Type Hamed Description Modified Date Modified By When Run

r =) a Innowvatar MEw 6/8/2005 2:268 PM ARAS-CORPYtkohl

|l & User Directory MEw 6/8/2005 2:26 PM ARAS-CORPYtkohl

-
@ I T

Click on the properties icon in the Edit column for the Report you want to export.
This will open the Properties Page for the Report.

Click on the "Edit" link below the "Report Definition" label. This will open a dialog
asking for confirmation that you want to save the RDL file.

2 Report Manager - Microsoft Internet Explorer

= A ; =
Que - @ 8] @ B P Joroeies @ (3- 5 B~ B
iress | ) hetp:lapkopd7 Reports FagesiRepcet, acgorTiemP st 2fnruvator s Reports o 2fUser +RepcrtaSelactedTabld=PropertiesTab v B ik * @seaor B
: My & — Site St m
- SAQL Server Reporting Services Eame | i I | Helo
5| Home > Innovator Reports > Search for:
28 User Report :
e
Modified Date: 2/6/2007 7:34 PM
General Modified By:  ARAS-CORP\mbeaulieu
Data Sources Craalio; Date: 2/6/2007 ?:34bPM ,
Created By:  ARAS-CORP\mbeaulieu
Sunsution, Size: 20 KB
History
Sacurity Properties
Marne! \User Report File Download X
Description: | —
Do you want to open o1 gave this file?
OHide in list view E Mame: User Repart.rdl
aull - nm Dusfirstion
ort Definition ——————————————— - :::( i, 194D
Edit
[ Apply [ [ Create Linked Report ] I Open ] [ Save I l I
Create a linked report when you want to
‘Whils fikes from the Intemet can be wsehul, some fles can poteriialy
haem ypour compuber, I wou do not it te souce, do not open of
sarve this fle. What's the sigh?
] &4 Local intranet
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Click the "Save" button, which will open a File "Save As" dialog.

Save i | 159 Innaveator Beparts

v| (« Wz =T

D

My Recent
Documets

() Innovatar Reports

Desktop

)

My Docurments

o

My Computer

e

File name: |User Report hd |

Save ]

by Metwork Save as type: | Report Defintion File w |

[ Cancel ]

7.3 Import the RDL

Log into the target Aras Innovator Server:

1. Navigate to the main tree item /Administration/Reports.

2. Click on the main menu Reports button and the "Report Manager" choice.

3. The Report Manager page will open in a new window as shown below:

Note: This same page can be opened from your browser with the URL

http://localhost:8080/Reports

] Report Manager - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help
A & g ; > R
Qs - © MR G P Jrrome @ -5 F- 3
Address |@ http:jflaptop0i7 reports P agesfFolder . aspxiewMode=Detai V‘Go Links @ snagt B &
Home | My Subscriptions | Site Settings | Help
S0L Server Reporting Services

X Ed ‘ [y New Folder }*New Data Source b Upload File 5] Report Builder i Hide Details
O Edit Type Mamed Description Modified Date Modified By Whan Run

O [y @ Data Sources 2/9/2007 9:47 AM ARAS-CORPYmbeaulieu

O oy [ ] Innovator Reports 2/7/2007 12:10 PM ARAS-CORPYmbeaulieu
@ ‘3‘ Local intranet

Click on the "Innovator Reports" Folder and you will see a list of Reports and Shared

Data Sources. Click the "Upload File" button in the middle of the screen.
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http://localhost:8080/Reports

AR

eport Manager - Microsoft Internet Explorer
o

Fils Edt ew Favores Tooks Help
Qe - Q- [H B @ Psowan Frrans @ -5 [F- B
Addross | ] Hetp:flsptop0Tjreports|Fages Folder  sspxTYisniMode=Det sl v B0 s ® @snagn B &
Home | My Subscriptions | Site Settings | Help
SOL Server Reporting Services
']i Home . Search for;
s Contents JSTERLTE
x "M | CuMNew Folder +3MNew Data Source GJ Upload Fila o Report Builder #i Hide Details
O Edit Type  MNamed Descriptim——odified Date Modified By When Run
o = [ Data Sources 2/9/2007 9:47 AM ARAS-CORP\mbeauliey
o = =] Inneyator Reports 2/7/2007 12:10 PM ARAS-CORPyMbeaulieu

S Local intranet:

&l

This will open the Upload File page.

2 Report Manager - Microsoft Internet Explorer = 18]
.gr

File  Edit “iew Favorites  Tools  Help

Address |é§| http:/ flaptop07 fReports/Pages/ Import, aspxItemPath=:2fInnovator+ReportséiR edire V| Go

eBack - \_/J \ﬂ @ _:j /;__\J Search “f;:( Favorites ﬁ‘; [j'\:- :_,:_; - ﬁ
Links ” & snaglt B

Home | My Subscriptions | Site Settings | Help

SOL Server Repaorting Services
Upload File Search for:| |

Upload a report or resource into Innovator Reports, To upload a report, choose a report definition (rdl)
file.
File to upload: |

|[ Browse... |

MName: |New Item |

[Jowverwrite item if it exists

‘-"_-J Local inkranst

&

Copyright© 2013
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Click the "Browse..." button, which will open a File Selection dialog for you to select

the RDL file to upload.

Select the RDL file and click the "Open" button. This will insert the file name in the
File to upload field and also set the Name field to the name of the RDL file selected.

If this is a new version of an existing Report select the Overwrite checkbox. Click the
"OK" button to complete the upload. The RDL file will be uploaded to the target
ReportServer and deployed. You should see the new Report in the Folder now.
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A Report Manager - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help

Qo= - O - [¥ @) - B3

Address |5§| http:/ flaptopl?/Reports/Pages/Import. aspxrltemPath="%2f Innovator-+HReporbsaaRadire V| Go Lk 7 @ snaon B

{ ;j /-._\J Search \51'\'( Favotites {‘j(

Hore | My Subscriptions | Site Settings | Help

Search fDr:| |

= S0L Server Reparting Services
Q‘j Upload File

Upload a report or resource into Innovatar Reparts, To upload a report, choose a report definition {.rdl}
file.

File to upload: |

L |[ Browse...

]

Mame: |New Item

write itern if it exists

é:l \ﬁ Local intranet

7.4 Select the Shared Data Source

The Data Source for the Report may need to be changed if the name of the Shared
Data Source is different on the target ReportServer. Click on the properties icon in
the Edit column for the new Report that was uploaded. This will open the Properties
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page for the Report where you can select its Shared Data Source.

Home | My Subscriptions | Site Settings | Help ;l

Search fDr:l EI

SOL Server Reporting Services
Home > Innovator Reports =
User Directory

@ TR History | Subscriptions

Modified Date: 6/23/2005 7:54 AM

General Modified By:  WICECITYtkohl
Data Sources Creation Date: 6/23/2005 7:54 AM
. " Created By: YICECITY tkohl
Hecdmon Size: 14 KB
History
Sacurit Properties
Mame: "Jser Directory
Description: =]
=
7 Hide in list view
Report Definition
Edit Update
Apply Create Linked Report Delete | Maowve |

Create a linked report when you want to use different security or parameters with the report.

[

Select the "Data Sources" navigation link. The first choice "A shared data source"

should be selected.
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SOL Server Reporting Servicas Home | My Subscriptions | Site Settings | Help ;I

Home > Innovator RBQDI’tS > Search for: GDl

User Directory

@Pmperﬁes History | Subscriptions

Innovator
General
Data Sources ® 4 shared data source
Execution JInnowvator Reports/Innovator  Browse
History © 4 custom data source
Secunty . . -
connection Type:  [Microsoft SOL Server =l
Connection String: =

Connect Using:
@ The credentials supplied by the user running the report

Display the following text to prompt user for a login name and password:

IEntEr 3 user name and password to access the data source:
T Use 35 windows credentials when connecting to the data source

0 Credentials stored securely in the repart server

User name: I

Password: |

¥ Use as Wwindows credentials when connecting to the data source
[T Impersonate the authenticated user after a connection has been made to the data source
€ Windows NT Integrated Security

@ Credentials are not required

Apply

[

If the named Shared Data Source is incorrect for this ReportServer click the
"Browse" button to open the Shared Data Source page. Navigate the Folders to
locate the desired Shared Data Source, select it, and click the "OK" button.

Home | My Subscriptions | Site Settings | Help ;l

SOL Server Reporting Services

Home = I_nnD\.ratDr Reports = Search FDr:I El
User Directory

@ AT T History | Subscriptions

Browse report folders to select a shared data source to use with this report.
General

Data Sources Location: |/Inn|:|uat|:|r Reports/Innovataor

Execution E-C] Hame
History EI{:I Innovator Reports
Security ﬁ Irnouaton
oK | Cancel | H
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8 Graphical Query Builder

The Visual Studio report designer has a graphical query builder that can be useful
when constructing reports for deep item structures such as the Project Item
structure.

3 |

On the Data Tab in the report designer select the icon _—_
design window.

which opens the graphic

22 Report Project1 - Microsoft Development Environment [design] - Report1.rdl [Design] -2 x
Fle Edit View Froject Build Debug Format Report Tools Window Help
EEHG P BR| - -E-B| ) pehug | o Start T AEERE-,

s |mar o | R e RSeS| B - - N .
Fields 2 x|| StartPage Reportl.rdl [Design] | 4 b = |[Solution Explorer - Report Projectl 2 X |
[Fusps1 Bl (R = Layout | B, Preview = E=
= Dataset: ENGPBL i s8] Z = [ solution Report Project1’ (1 project)
atasel |5 [ 3 B RED £ 51 Report Projectl

- 3 Shared Data Sources
-« FNGP61.rds

project_number

Bl £33 Reports
Eiiw:?:\mg,wue pi| - [ ReportL.rdl
o | dmesticaton #% WBS_ELEMENT M
[keyed_name - * (8ll Coumns) - =suB_wBs H
. |

[is_top = (All Columns)
name [
[ lproi_num = [ lclassification
L= [ lkeyed_name
[ereated_on |

# WBS_ELEMENT1 !
= (all Columns)
id
is_top

“lvame
or_num

& WBS_ACTIVITY2

| |permission_id

tte_due_original

Bl

& ACTIVITY2 | & IDENTITY H
created_on - [I* (I Columns)
[ oreated by i m =i []name

[ Jlabel
(vid
[ereated_on

v
:‘mudlﬁed on

<

| Column | Alias |Table [output [SortType [Sort Order |Criteria

[SELECT PROJECT.name, PROJECT program, PROJECT,wbs_d, ACTIVITYZ,name AS Activity, ACTIVITY2.fgp_Tva,
ACTIVITY2.description, ACTIVITY2 expected_duration, ACTIVITY2.fngp_role, ACTIVITY2.date_due_act,

ACTIVITY2.date_due_sched, WBS_ELEMENT1.name AS Phase, WBS_ACTIVITY2.sort_order AS seq,
SUB_VIBS. sort_order AS phaseseq, ACTIVITY2.owned_by_d, [IDENTITY].id, [IDENTITY].name AS WHO,
ACTIVITY2.date_due_criginal

WBS_ELEMENT INNER JCIN
PROJECT ON WBS_ELEMENT.id = PROJECT wbs_id TNNER JOIN
SUB_WBS ON WBS_ELEMENT.id = SUB_W/BS source_id INNER JOIN
WES_ELEMENT WES_ELEMENT 1 ON SUB_WES.related id = WBS_ELEMENT Lid INNER JOIN
WBS_ACTIVITY2 ON WES_ELEMENT1.id = WBS_ACTIVITY2.source_id INNER JOIN
ACTIVITY2 ON WES_ACTIVITY 2 related_id = ACTIVITY2.id INNER JOIN
[IDENTITY] ON ACTIVITY2.owned_by_id = [IDENTITY].id

IWHERE {PROJECT.name = ENAME)

IORDER BY phaseseq, seq

[or... lor... [or...

IFROM

[program [wbs_id [Activity [fnap_rva | deseription |expected_duration| fngp_role date_due_act date_due = o
V-12 Mini-Van SFACAS7620074E¢ Act 1-5 #00FF00 <NULL> 9E831C5483394BC 5/17/2005 5/16/2005
V-12MiniVan | GFACAS7620074ES Act 1-1 SFFFFO0 <NULL> 0 G200AB00443E4AS 5/19/2005 5/31/2008
V-12 Mini-Van SFACA57620074ES Act 1-2mark13 <MNULL> <NULL> <NULL> 9E831C54B3394BC <MNULL> 5/31/2005
V-12 Mini-Van SFACAS7620074E¢ Act 1-3 <NULL = <NULL> <NULL> <NULL> <NULL> 5/31/2005
V-12Mini-Van  SPACAST620074E5 Act 14 <NULL> <NULL> <NULL> <NULL> <NULL>

<HULL>

3 Toobox = Fields

| Ready

Manipulating the graphics automatically creates the correct query with the joins.
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& PROJECT
project_number
Dscheduling_type
wbs_id
Ddassiﬁcaﬁon
gkeyed_name

&% WBS_FLEMENT M

& SUB_WBS
= (all Columns)
id

Ddassiﬁcaﬁon
Dkeyed_name

gcreahed_on LI

& WBS_ELEMENT1 N
* (All Columns) -
[ lid

& WBS_ACTIVITY2 i
|_[permission_id %:a_:ep

gproj_num ;I

& ACTIVITY2 _ | & IDENTITY

created_on - * (Al Columns)

:Icreahed_by_id name

Zowned_by_id ol Dlabel

:‘managed_by_id id

gmodiﬁed_on d cheahed_on LI

This results in the SQL query:

SELECT PROJECT.name, PROJECT.program, PROJECT.wbs id, ACTIVITY2.name AS Activity,
ACTIVITY2.fngp ryg, ACTIVITY2.description, ACTIVITY2.expected duration,
ACTIVITY2.fngp role, ACTIVITY2.date due_act, ACTIVITY2.date due_sched, WBS_ELEMENTI1.name
AS Phase, WBS ACTIVITY2.sort order AS seq, SUB WBS.sort order AS phaseseq,
ACTIVITY2.owned by id, [IDENTITY].id, [IDENTITY].name AS WHO, ACTIVITY2.date due original
FROM WBS_ELEMENT INNER JOIN

PROJECT ON WBS_ELEMENT.id = PROJECT.wbs_id INNER JOIN

SUB_WBS ON WBS_ELEMENT.id = SUB_WBS.Source_id INNER JOIN

WBS_ELEMENT WBS ELEMENT1 ON SUB WBS.related id = WBS ELEMENT1.id INNER JOIN

WBS ACTIVITY2 ON WBS ELEMENT1.id = WBS ACTIVITY2.source id INNER JOIN

ACTIVITY2 ON WBS_ACTIVITYZ.related_id = ACTIVITY2.id INNER JOIN

[IDENTITY] ON ACTIVITYZ.owned_by_id = [IDENTITY].id
WHERE (PROJECT.name = QNAME)
ORDER BY phaseseq, seq
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9 Date Related SQL Queries

AML is the language of Aras Innovator, but some external add-ons do connect to
Aras Innovator on a direct SQL level. Because Aras Innovator stores DateTimes in
SQL Server as UTC, we have provided an add-on function for Microsoft SQL Server
that will allow the easy conversion of DateTime to and from UTC.

To convert DateTime values from UTC to a specific time zone, use the function
ConvertTolLocal ({value},{Time Zone}). The time zone should be specified
according to the registry key name of the time zone desired. (See Aras Innovator -
Configuring Internationalization) To use the DEFAULT parameter for the {Time
Zone}, it is required that a value be set for CorporateTimeZone.

Example:

select item number, created on
from innovator.Document

Would be written as

select item number, innovator.ConvertToLocal(created_on,DEFAULT) as
CreadtedOn
from innovator.Document

Or

select item number, innovator.ConvertToLocal(created_on,'Eastern

Standard Time') as CreadtedOn
from innovator.Document

To convert DateTime values from a specific time zone to UTC, use the function
ConvertFromLocal({value},{Time Zone}). The time zone should be specified
according to the registry key name of the time zone desired. (See Aras Innovator -
Configuring Internationalization) To use the DEFAULT parameter for {Time Zone}, it
is required that a value be set for CorporateTimeZone.

Example:

update innovator.Documnet
set effective date '1/1/2007 00:00:00.00"

Would be written as

update innovator.Documnet

set effective date = innovator.ConvertFromLocal ('1/1/2007
00:00:00.00", DEFAULT)
Or
update innovator.Documnet
. set effective date = innovator.ConvertFromLocal ('1/1/2007

00:00:00.00"', '"Eastern Standard Time')
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This will allow users to write queries in a familiar time zone context.

select item number, innovator.ConvertToLocal (release date, DEFAULT) as
ReleaseDate

from innovator.Document

where created on >= innovator.ConvertFromLocal ('1/1/2007
00:00:00.00", DEFAULT)
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10 Cookbook

This section provides a set of recipes for doing common reporting tasks.

10.1 User Input Reports

You need a Form to collect user input for Named Parameters for the SQL query for
Reporting Services based Reports.

Technique

An XSLT based Report is used to present a Form to collect the user input. The user
input is mapped to a query_string for the Report Server request via the
RSGatwway.aspx page.

In the ReportTool/Templates folder there is a UserInputTemplate.txt file that you can
use as a template to build the XSLT based Form. This provides a generic way to
define the Fields for the user input Form, which opens a modal dialog with a generic
HTML page dynamically building the Form based on the Fields defined in the
template file.

Note: To use “User Input Reports” you must add the following script to the
UserInputDialog.html located in the ReportTool folde and save itr:

<script type="text/javascript" src="../../javascript/AddConfigurationLink.js"></script>
b yp J b J b 9 J b

Procedure for building a user input Form for Reporting Services based Reports with
Named Parameters:

Login to Aras Innovator as admin.
Navigate to the Administration->Reports off the Main Tree.

Open a new Report Item.

A W N

Set the Report Item properties as following:

a. Name = the name of your Report as deployed in Visual Studio to the
Report Server.

b. Type = Generic or ItemType depending on when you want the Report
to appear on the Report menu; Generic always, ItemType only when
that ItemType is selected off the Main Tree.

C. Location = Server; this is required because the XSLT page will return
an HTML page with JavaScript that needs to be parsed and Client side
Report only writes the transformed page to the browser window and
thus the JavaScript is not parsed.

d. Target = Window; again because the page has JavaScript we need a
window to parse the JavaScript. This page will present status info to
the user as the Report is being processed and the final Report results
will be shown in this same window.

e. Report Query = leave blank it is currently not used for this purpose.

5. Click on the Stylesheet Tab to insert the template code for setting up the
Fields for the modal dialog:

a. Scroll to the bottom of the page.
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b. Open the ReportTool/Templates/UserInputTemplate.txt file and select
the whole document content.

c. Replace the <body> tag in the Stylesheet Tab with the content from
the UserInputTemplate.txt file.

d. Edit the userlnputFields object, which is an IOM Item by setting the
properties for the Item to match the Named Parameters for the SQL
query for the Report as deployed to the Report Server.

/1]

/// Set the User Input Fields...

/// The property names must match exactly the names you used for the
/// Named Parameters in the SQL Query.

/1]
/// For example, this SQL Query for the GetParts Report in the

/// Report Server has the following
/// Named Parameters: part_number, description, and cost;

/1]
/// SELECT  part_number, description, cost
/// FROM MY_PART

/// WHERE (part_number LIKE @part_number)

/// AND (description LIKE @description)

11/ AND (cost LIKE @cost)

/17

var userInputFields = opener.top.myInnovator.newltem();
userInputFields.setProperty('part_number’, '%");
userInputFields.setProperty('description’, '%");
userInputFields.setProperty('cost’, '%"');

e. Click the Apply button at the bottom of the Stylesheet Tab.
f. Click the Save button on the Report Tool toolbar.

That's it, the Report Item should now appear on the Report menu and when selected
the User Input Dialog should open. When the user clicks the Submit button the user
input is mapped as a query_string and the actual Report is requested from the
Report Server via the RSGateway.

If the future the Named Parameters and Report nhame will be derived and the XSLT
based Report Stylesheet will be automatically generated but for now you need to set
these values when using the template.

If you want to add validation or rearrange the Fields on the Form you can make a
copy of the ReportTool/UserInputDialog.html page and modify it to meet your needs.

If you have the need to pass attributes or property values from the selected context
Item use the following technique to set the values to hidden form fields:

1. Edit the section from the UserInputTemplate.txt file to pack the desired Item
attributes and properties into hidden form fields:

<!--
The following is an example for passing attributes and properties
from the selected context Item as hidden fields.

- For example, pack the id attribute from the context Item using
XSLT Attribute Substitution and nested xsl tags for the properties.
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<form>
<input type="hidden" name="id" value="{//Item/@id}/>
<input type="hidden" name="name">
<xsl:attribute name="value" select="//Item/name"/>
</input>
</form>
-->

2. Also edit the section from the UserInputTemplate.txt file to pass those hidden

field values as Field values for the user input dialog:

/1
/// If there are properties from the selected context Item packed

/// as hidden fields on the form use this:

/1]

userInputFields.setProperty('id', document.form[0]['id'].value);
userlnputFields.setProperty(‘name’, document.form[0]['name'].value);
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10.2 Report Chooser

You need a dialog to present a set of Reporting Services based Reports to choose
from for the selected Item.

Technique

An XSLT based Report is used to present a dialog to get the Report choice. The user
selection is mapped to a query_string for the Report Server request via the

RSGatwway.aspx page. This is similar to recipe 9.1 User Input Form but in this case
we do want the ID for the selected Item to be passed as a Named Parameter on the
query_string.

In the ReportTool/Templates folder there is a file ChooseReportTemplate.txt that you
can use as a template to build the XSLT based Form. This template provides a
generic way to define the Reports choices and it opens a modal dialog.

Procedure for building a Report Chooser dialog for Reporting Services based Reports:

1. Login to Aras Innovator as admin.

Navigate to the Administration->Reports off the Main Tree.

2
3. Open a new Report Item.
4

Set the Report Item properties as following:

a.

e.

Name = the name of your Report as deployed in Visual Studio to the
Report Server.

Type = Item (You do not need the report_query template when
prompted).

Location = Server; this is required because the XSLT page will return
an HTML page with JavaScript that needs to be parsed and Client side
Report only writes the transformed page to the browser window and
thus the JavaScript is not parsed.

Target = Window; again because the page has JavaScript we need a

window to parse the JavaScript. This page will present status info to

the user as the Report is being processed and the final Report results
will be shown in this same window.

Report Query = leave blank it is currently not used for this purpose.

5. Click on the Stylesheet Tab to insert the template code for setting up the
Report choices for the modal dialog:

a.
b.
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/1
//

Scroll to the bottom of the page.

Open the ReportTool/Templates/ChooseReportTemplate.txt file and
select the whole document content.

Replace the <body> tag in the Stylesheet Tab with the content from
the UserInputTemplate.txt file.

Edit the AddReport() calls to the Report choices:

/
/ Add your Report Choices here...
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/1]

AddReport('Reportl’, 'Report One', 'rs:Format=Excell");
AddReport('Report2', 'Report Two', 'rs:Format=HTML4.0");
AddReport('Report3’, 'Report Three', 'rs:Format=PDF');

e. Click the Apply button at the bottom of the Stylesheet Tab.
Click the Save button on the Report Tool toolbar.
Navigate to the Administration->ItemTypes off the Main Tree.

Search for the ItemType for this Report.

© ® N O

Edit the ItemType and select the Reports Tab.
10. Add an Existing related Item and select this Report.
11. Click the Save button on the ItemType toolbar.

That's it the Report should now appear on the Report menu when the Item is
selected. When the user clicks the Submit button the selected Report the actual
Report is requested from the Report Server via the RSGateway.

The ID for the selected Item is automatically passed as a Named Parameter np:id so
you must name your Named Parameter in the SQL query with lowercase id also.

10.3 Date Selector

You need a Form with two date fields to collect user input for Named Parameters for
narrowing the results of a SQL query for Reporting Services based Reports.

Technique

A Client-Side Report is used to call JavaScript which will present the user with a
dialog for selecting a date range. Upon the selection of the date range the user will
click on the “"Run Report” button which will call the RSGateway.aspx page directly
passing the date range as named parameters to the report query.

Procedure for building a Date Selector dialog:

1. Log into Aras Innovator as an administrator

2. Navigate to Administration->Methods and create a new method
a. Name = run_report_button_click
b. Type = JavaScript
c. Method Code =

var fromDate = document.forms[0].from date.value;
var toDate = document.forms[O].to_datg.value;
if (new Date (toDate) < new Date (fromDate))
{
alert ("To Date must be greater then from date");
}
else
{

var retVal=new Array();

retVal["runReport"]="1";
retVal["to date"] = toDate;
retVal["from date"] = fromDate;
window.returnValue = retVal;

window.close () ;

}

3. Save, Unlock, and Close method
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4. Navigate to Administration->Forms and create a new Form
a. Name=DateRangeSelector
5. Add a new field
a. Name=form_setup
b. Field Type = HTML
C.

Label = <empty string>

d. HTML Code
<font size="6">Date Range Selector</font>
<script>

document.isEditMode=true;
var myInnovator = dialogArguments.innovator;
setTimeout ('startup();"',100);

function startup()

{

var displayDate = new Date();

document.forms[0].to date.value=fixDate (displayDate);
document. forms[0].from date.value=fixDate (displayDate);
}

function fixDate (inDate)

{

var Day = inDate.getDate();

var DayStr = (Day < 10) ? '0O' + Day : Day;

var Month = inDate.getMonth();

Month++;

var MonthStr = (Month < 10) ? '0' + Month : Month;

var cntx = myInnovator.getIl8NSessionContext();
return cntx.ConvertFromNeutral ( inDate.getFullYear ()

" + MonthStr + "-" + DayStr, 'date', 'short date');
}

</script>

6. Add a new field
a. Name = from_date
b. Type=Date
c. Label = From Date
7. Add a new field
a. Name = to_date
b. Type = Date
Cc. Label = To Date
8. Add a new field
a. Name = run_report
b. Type = Button
c. Label = Run Report
d. Add a new Field Event
i. Method Name = run_report_button_click

ii. Event = onClick
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9. Save, Unlock and Close Form

h

& Form - DateRangeSelector (read only) - Windows Internet Explorer o e S

File Edit Views Search Actions Reports Tools Help
a 48| & L} % £

DateRangeSelector' Fiel,. | Ficld Type  Field Label  Field Physical Field Border  Field CSS  FieldEvent  FormPro ‘| "

Hame from_date Display Length

htmi0
Field Type Date

run_report Data Source
i to_dat
iﬁ o-aee Background Color
Date Range Selector
CFrombate To Date
il : I
Run Report

Ready ltems 1-1of 1. Page 1 of 1 25 bvaron i

10. Navigate to Administration->Methods and create a new method
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a. Name = Report_Date_Select
b. Method Code:

var param = new Object();

param.title = "Date range selector for Reporting Services Report";

param. formId = "AODC688E91834EC98E013A8046F60692"; //ID ofDate Range Selector
Form

params.isEditMode = "1";

param.aras = top.aras;

param.innovator = this.getInnovator();

var res = showModalDialog ("ShowFormAsADialog.html", param,
"dialogHeight:300px; dialogWidth:450px; " +
"status:0; help:0; resizable:0; scroll:0;");
// debugger;
if (res)
{
var fromDate = top.aras.convertToNeutral (res["from date"], 'date',
"short date");
fromDate= fromDate.substring (0, fromDate.indexOf ("T")) ;
var toDate = top.aras.convertToNeutral (res["to_date"], 'date',6 "short_date");
toDate= toDate.substring(0,toDate.indexOf ("T")) ;

var reportName = "TestReport"; //Your Report Name Here
var url = top.aras.getServerBaseURL() + "RSGateway.aspx?irs:Report=" +
reportName;

//Date Variables in this example is fromDate and toDate
url += "&amp;np:fromDate=" + fromDate;

url += "&amp;np:toDate=" + toDate;

//url += "&amp,rs:Format=Excel";

var w = window.open(url, "TestReport",

"width=800,height=600, status=yes,resizable=yes, toolbar=no,menubar=no,scrollbar
s=yes") ;

}

return "<html></html>";

11.Save, Unlock, and Close method
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12. Navigate to Administration->Reports and create a new Report
a. SSRS Date Selector
b. Type = Generic
c. Location = Client
d. Target = None
e. Method = Report Date Select
13. Save, Unlock and Close report

The new generic report should appear in Reports Menu. Your SQL query will now
accept the name parameters of fromDate and toDate into the SQL query as a way to
narrow your results in a where clause.

You must simply modify the Report_date_Select method to point to the proper
Report and use the proper ID of the DateRangeSelector form
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